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RECTANGULAR HORN ANTENNA PROJECT 1-1

1 Getting started project: A rectangular horn

1.1 Example overview

This example uses a completed model to familiarise the user with the FEKO components and
workflow. It is intended for users with little or no experience with Altair FEKO. The various as-
pects of the different FEKO components are discussed as they are encountered. A demonstration
model of a completed horn antenna with results is used as an example. The model will not be
constructed as part of this demonstration, but instead be used to demonstrate tasks that are often
required in the FEKO components.

The horn model is similar to the model used in the demo video1. It is recommended that the
demo video be watched before working through this example.

Figure 1-1: Illustration of the horn antenna.

1.2 Before starting the example

Before starting this example, please ensure that the system satisfies the minimum requirements
before starting. A user should also ascertain whether the topics presented in this example are
relevant to the intended application and FEKO experience level.

The topics demonstrated in this example are:

• General program flow of the FEKO.

• Launching CADFEKO.

• The CADFEKO layout.

• The POSTFEKO layout.

• Viewing the simulated far field and near field results in POSTFEKO.

1The demo video is a short movie demonstrating the solution of a horn antenna similar to the example that is
shipped with the Altair FEKO installation. It may be found in the doc subdirectory of the Altair FEKO installation. For
Windows installations, this file is an .exe file, which may be executed directly or from the Windows start menu. On
Linux installations, the demo is opened inside an .html file. This demo video, as well as other FEKO demonstration
videos may be viewed on our website.
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The requirements for this example are listed below.

• FEKO 2017.2 RELEASE or later should be installeda with a valid licence.

• It is recommended that the demo video be watched before attempting this example.

• This example should not take longer than 30 minutes to complete.

aSee the FEKO Installation Guide to install Altair FEKO.

While working through this example, the steps should be followed sequentially, otherwise expla-
nations may seem to be out of context.

1.3 Different FEKO components and workflow

The components that are most visible to users are CADFEKO, POSTFEKO and the FEKO solver.
CADFEKO is the CAD component where the model is created and solution settings are applied.
Once the model has been created, it needs to be meshed and then the kernel is run to produce
simulation results. The results are then viewed, manipulated and exported in the post processor,
named POSTFEKO. After viewing the results it is often required to modify the model again in
CADFEKO and then repeat the process until the design is complete. Figure 1-2 illustrates this
simple workflow. View/export resultsUse POSTFEKO

Mesh the model

EM validate the 
model

Use CADFEKO

Create/modify 
geometry

Set solution settings

Define frequency, 
sources and requests

Create/modify model

View geometry
and results

View geometry
(for validation)

Use POSTFEKO

Run FEKO solver

Run PREFEKO

Use EDITFEKO

Create/modify 
geometry

Create *.bof file

Create and edit
*.pre file

Create/modify 
geometry

Run FEKO solver Run solver

Use POSTFEKO

Run FEKO solver

Use CADFEKO

Create new 
graph/display

Run solver

Add / view results

Export results / 
generate report

Post-processing of 
results / scripting

Run FEKO solver

Create new 
graph/display

Add / view results

Post-processing of 
results / scripting

Export results / 
generate report

Mesh the model

EM validate the 
model

Create/modify 
geometry

Set solution settings

Define frequency, 
sources and requests

Use CADFEKO Use POSTFEKO

Figure 1-2: Typical FEKO workflow when using CADFEKO, POSTFEKO and the FEKO solver.

A text based model editor, EDITFEKO, is also available for constructing models and solution
configurations in a text file. EDITFEKO usage is not covered as part of this example since it
should only be required by advanced users who are already familiar with FEKO.

The sections that follow will walk the user through the workflow and introduce the interfaces of
the FEKO components as they are encountered. The first component in the workflow is CADFEKO.

1.4 Brief introduction to CADFEKO

When starting a blank instance of CADFEKO or POSTFEKO (no models are loaded), the start
page will be displayed, giving quick access to functions that are required most often. The start
page allows the user to:
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• Create a new model.

• Open an existing model or select a recently used file from the list.

• Access the various documentation resources. There are links to the PDF documents, demon-
stration videos as well as a link to our website where other resources are available including
demonstration models and articles where FEKO has been used. It is recommended that the
videos be watched by first time users.

The help assistant is available by clicking the green question mark icon at the top right of
the start page. The context sensitive help can be launched at any time for context sensitive
documentation by pressing <F1> while working in a FEKO component.

All the functionality available on the start page is also available at other locations in the interface,
but the start page makes these features readily available when the application is launched.

Figure 1-3: The CADFEKO start page.

Application layout

The main elements and terminology used to describe the CADFEKO window will briefly be pre-
sented. This terminology will be used extensively in the chapters to follow as well in the manu-
als. Although most of the components are standard Windows interface components, time will be
spent discussing these elements.

July 2017 FEKO Getting Started



RECTANGULAR HORN ANTENNA PROJECT 1-4

1
2

3

4

5

6

7

8

9

10

11

1. Quick access toolbar These items give the user quick access to controls that are used often.
These include the following two lists.

• Grouped on the left side of the toolbar are model actions that are used frequently.

– New model
– Open model
– Save model
– Undo and Redo

• Grouped on the right side of the toolbar are icons to launch other FEKO components.
These icons are located next to the help icon [10] and are collectively referred to as
the Application Launcher.

– FEKO solver
– POSTFEKO (for the display of the results obtained by the FEKO solver)
– EDITFEKO
– PREFEKO

2. Ribbon The ribbon contains the application menu, default tabs and contextual tabs. A more
detailed description of the ribbon and its components is available further on in this section.

3. Configurations list The configurations list contains the configurations (standard configura-
tion, multiport S-parameter and characteristic modes) that have been defined in the model.
By default a new model starts with a single standard configuration, but simply adding a
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multiport S-parameter or characteristic mode will create a new configuration. Multiple
configurations allow a user to perform efficient simulations of different configurations (dif-
ferent loads or sources) in a single model.

4. Model tree The Model tree consists of more than a single tree. The Construction tab and
Configuration tab make two trees available to the user. Definitions such as variables, media
and named points are listed in both trees giving easy access to these items in both tabs.

Construction tree The construction tree is where the user creates and edits the geometry.
Ports, mesh refinement rules, infinite planes and arrays can also be constructed.

Configuration tree The configuration tree displays the selected solution configuration in-
cluding sources, loads and requests. Configuration settings can be specified globally
or specific to a configuration.

5. Details tree The details tree contains the geometry object details (wires, edges, faces and
regions) for the geometry or mesh part that is selected in the construct tree. Custom
solution and mesh settings may be set in the details tree.

6. Status bar The status bar gives the user quick access to macro recording, general display
settings, tools, selection method and type. It is an “active” status bar since most of the
items on the status bar are icons that perform actions or change display settings.

7. Message window The message window displays messages regarding user interaction such
as geometry creation, meshing, source configuration. It also provides details regarding
warnings and error messages. Errors and warnings in the message window will provide
links to the corresponding geometry objects in the details tree which resulted in the error
or warning.

8. Notes view The notes view can be used to document the model details. Additional com-
ments, explanations or descriptions can be added for later reference. The notes view is not
displayed by default, but can be activated on the View tab.

9. 3D view The 3D view enables the user to visualise the geometry and solution settings (such as
far field requests). Note that the configuration items, such as the requests, are displayed for
the currently selected configuration and that they are not displayed when the Construction
tab is selected. This allows the user to concentrate on the CAD when the Construction tab is
selected. Additional visualisations such as cutplanes and symmetry can also be displayed.

10. Help The Help icon gives the user quick access to the FEKO manuals. Context sensitive help
is available in all FEKO Suite GUI components by pressing <F1> at any time.

11. Search bar The search bar enables the search for a specific action or keyword in CADFEKO.
Entering a keyword in the search bar will populate a dropdown list of actions as well as
the location of the particular action on the ribbon or context menu. Clicking any one of the
items in the list will execute the action.

The ribbon menu

The ribbon consists of several elements. Please take note of the terminology as it will be used
extensively in the chapters to follow.
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1 2 3

4 5

1. Application menu The application menu appears when a user clicks the application menu
button. The application menu is similar to the standard file menu of an application. It
allows saving and loading of models, import and export options as well as giving access to
application wide settings. The FEKO updater can be launched from the application menu
and it also provides a list of recently accessed files.

2. Default tabs The default tabs are always visible (when enabled) and contain general actions.
Most of the tabs in CADFEKO are default tabs.

3. Contextual tabs The contextual tabs are context sensitive. These tabs are displayed and
changed depending on the currently selected object. The 3D view and schematic view
have context sensitive tabs in CADFEKO. A coloured tab marker bar above the tabs indicate
the current context.

4. Ribbon group Similar actions or commands are contained in a group within a tab.

5. Dialog launcher Clicking the dialog launcher will launch a dialog with additional settings
that relate to that group. Advanced options that are not used regularly may be found by
clicking the dialog launcher button.
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The ribbon may also be navigated by
means of the keyboard by using the keytips.
When pressing and releasing the <Alt> or
<F10> key, the tab keytips are displayed.
Typing the indicated keytip will open the
tab or perform the selected action.

1.5 Opening the first model in CADFEKO

Now that the basic components and structure of CADFEKO have been presented, open a
model in CADFEKO. The CAD model is stored in a *.cfx file. Start CADFEKO by pressing

the Windows Start button, typing ‘CADFEKO’ and running the application from the list of filtered
options. The model referred to in this example can be found in the

examples\GetStarted_models\Project1-Rectangular_Horn_Antenna

directory of the Altair FEKO installation or downloaded from our website.

From the start page in CADFEKO, click Open an existing model and select the Horn.cfx model.
The geometry of the horn should now be visible on the screen. The model can be used to
investigate the trees and lists to the left of the CADFEKO interface. The contents of these will be
discussed in more detail in the sections that follow.

Contents of the model

Since the horn example consists of a single configuration, the configuration list will not be dis-
cussed in detail. The first list on the left hand side of CADFEKO is the configuration list. For the
simple horn model it contains only a single standard configuration.

The model tree consists of the following tabs.

• Construction tab with an associated Details tree

• Configuration tab

Each tab contains trees that are relevant to either the model’s construction or its configuration
settings. Some entries are displayed on the trees of both tabs (such as variables, media and
workplanes).

Construction tab

The Construction tab contains the geometry representation of the
current model. It contains a list of the definitions such as variables,
media and workplanes. The model CAD (geometry or mesh) is also
listed in the tree.

Other elements may be defined from its context menus and will be
displayed in the tree once an item has been created. These include
named points, cable definitions, mesh refinements, plane/ground
settings and antenna arrays.

Optimisation searches and associated masks, parameters and goal
functions will be displayed in the tree.
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The Model branch is a visualisation of the geometry creation hierarchy. Parts are derived from
existing ones (for example, the individual parts used in a Boolean operation or the original part
before a split operation). The original (parent) parts are removed from the top level of the model
and listed as sub-branches under the new part in the model tree.

The term part is used for highest-level items. These can be at the root level under Model or in
the top level of an assembly. The model parts are visible in the 3D view.

Right-clicking any entry in the model tree will open an appropriate context menu. Double-
clicking an item in the model tree will display the Properties for that item.

When items are hidden, they are displayed with greyed icons in the model tree, but will not be
displayed in the 3D view. Hiding parts simplifies working with complex models containing a large
number of parts.

When a geometry or mesh part is selected on the Construction tab
of the model tree, additional information is displayed in a window
positioned just below. This is known as the Details tree.

If the Union1 part is selected, the details tree contains a tree with
two branches, namely Faces and Edges. If the horn geometry con-
tained a closed volume, a Regions branch would also be visible and
if wires were present, a Wires branch would be visible. By selecting
wires, edges, faces or regions in this tree, local properties such as
mesh size, coatings and solution method can be set.

Configuration tab

The Configuration tab consists of the Global and Configuration spe-
cific model settings and requests.

The following Global model settings may be defined from its con-
text menus: solver settings, the global frequency, global sources,
global loads, global networks and the global power settings.

The following Configuration specific settings may be defined from
its context menus: requests, frequency per configuration, sources
per configuration, loads per configuration and power per configu-
ration.

Setting the solution control

‘Ports’ are required to add sources and loads to the geometry. Ports define the positions on the
model where loads and sources can be attached. In this model, a waveguide port is added to the
end of the waveguide section feeding the horn. Ports can be added from the Ports group on the
Source/Load tab. A source can be added to the waveguide port by clicking the Waveguide source
icon (Sources on ports group).

The simulation frequency can also be set on the Source/Load tab under the Settings group.

Requests can be added from the Request tab. Both far field and near field requests can be made
from the Solution requests group.
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The model contains symmetry that can be used to decrease the required memory and solution
time. Symmetry is a model wide setting and can be set on the Solve/Run tab under the Solution
settings group. Two planes of symmetry are present. Magnetic symmetry can be applied in the
YZ plane (or the X=0 plane), while electric symmetry can be applied to the XZ plane (or the Y=0
plane). Note that nothing in the model needs to be changed to allow symmetry to be utilised,
except that the model must be remeshed.

1.6 Simulating the model

Once the model preparation is complete (geometry, sources, calculation requests and mesh are
completed), the solution is obtained by running the FEKO solver.

For this example, the solution is provided to save time. Before the model can be solved, it
must be meshed. The solver is invoked by clicking the FEKO solver icon on the Solve/Run

tab.

The run dialog will be displayed showing progress information as well as any warnings or errors
that are encountered during the simulation. No warnings or errors should be displayed for this
model. While the simulation is running, click Details to see the full text output produced during
the simulation. Also note that there are tabs where notes, warnings and errors will be displayed
allowing users to quickly see any problems that may have been encountered.
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1.7 POSTFEKO overview

POSTFEKO is used for validating the simulated model to ensure that it represents the
intended model and for the visualisation of computed results. POSTFEKO is launched

from the Solve/Run tab in CADFEKO. Note that the FEKO applications can also be launched from
the application launcher in the top right-hand corner of the screen. Launching POSTFEKO from
CADFEKO opens the correct model and does not display the start page.

The POSTFEKO window consists of the Ribbon at the top and the Result palette to the right. The
ribbon contains the application menu, default tabs, contextual tabs and the Quick access toolbar.
The configuration of the window is similar to the CADFEKO main window as described in the
previous chapter.

The various main elements and terminology of the POSTFEKO window will be briefly described,
but items that are the same in CADFEKO ([1], [2], [6], [9], [10]) are not repeated here.

1
2

3

4

5

6

7

8

9

10

3. Project browser The project browser lists all the models that are loaded in the current project
as well as imported data, stored data and scripted data. The visibility of the project browser
can be changed by selecting the View tab and clicking the Project icon.

4. Model browser The model browser displays information pertaining to the selected model in
the Project browser. The information includes optimisation, media, meshes, sources and
requests.

5. Details browser The details browser shows in-depth detail of any component selected in the
model browser.
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7. 3D View/2D graphs The 3D view enables the user to visualise the geometry, mesh, solution
settings as well as 3D results. The 2D graphs enable the user to view 2D results on a
Cartesian, polar, Cartesian surface graph or Smith chart. The 2D and 3D views each have
their own context-sensitive ribbon tabs. The window tabs of the 2D and 3D views may be
re-ordered by simply dragging it to the desired location.

8. Result palette The result palette enables a user to apply custom visualisation settings to 3D
results or 2D traces by customising the graph contents.

9. Help The Help icon gives the user quick access to the FEKO manuals. Context sensitive help
is available in all FEKO Suite GUI components by pressing <F1> at any time.

10. Search bar The search bar enables the search for a specific action or keyword in CADFEKO.
Entering a keyword in the search bar will populate a dropdown list of actions as well as
the location of the particular action on the ribbon or context menu. Clicking any one of the
items in the list will execute the action.

1.8 Viewing and validation of the model

POSTFEKO provides visualisation tools and settings to check that the model was created as in-
tended. In this section a number of features in POSTFEKO are highilighted to help the user
explore. Users are encouraged to have a look at and experiment with other features that are
available while navigating the ribbon tabs.

The horn model should be open showing the model and symmetry planes in the 3D view. The
distance measurement tool can be used to validate the specifications (dimensions) of the horn.

Display settings

By default the mesh edges will not be shown. The option to display the
triangle mesh edges may be set by clicking the 3D View context, Mesh
tab (Visibility group) and selecting Edges from the Metal dropdown
menu.

The Symmetry display can be disabled by selecting the Display tab in the 3D View context
and clicking the Symmetry icon (Method display group). The toggle icon for symmetry

display is also available on the status bar.

Sources in the model are displayed by default. The display of the source may be disabled
by selecting the Display tab in the 3D View context and clicking the Sources icon (Entities

group).

Restore the default zoom by pressing <F5>. The Zoom to extents icon can be found on
the View tab.
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Mesh and size validation

The next step in the validation process is to visually check the dimensions. One option for a quick
validation is to enable the tick marks on the axes.

Select the Display tab of the 3D View contextual tab and click the Tick marks icon.

For more precise validation of the dimensions, select the Mesh
tab of the 3D View contextual tab and click the Measure distance

icon to launch the Measure distance dialog. To measure a distance
between two points, hold down <Ctrl><Shift> and left-click on the
first and then on the second point. The distance will be displayed at
the bottom of the Measure distance dialog.

1.9 Near field results (3D)

The near field calculation which was requested in this example
has been performed and stored. To display this data in the 3D

view, select the Home tab and click the Near field icon. From the
dropdown menu select NearField1.

For the purposes of this example, the magnitude of the Ey component of
the field should be displayed in dB, together with a legend and contour
lines for better visualisation. In the Result palette, Quantity section, un-
select the X and Z checkboxes. Select the dB checkbox.

To place the contour lines on the display, select the Re-
sult tab. Click the Positions icon (Contours group) and

select Number of contours. Set the number of contours to 11
and click the OK button. To enable the display of the con-
tours, click the Show contours icon (Contours group).

1.10 Near field results (2D)

The near field results can be displayed on a 2D graph for comparison purposes.
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Select the Home tab and click the Cartesian icon to create a 2D graph. (Near field data
can also be displayed on a Polar graph if the near field points were requested in spherical

or cylindrical coordinates.)

Click the Near field icon (Add results group) and from the dropdown list, select NearField1.
This example compares the Ey and Ex components along the X direction (orthogonal to

the polarisation) about a quarter wavelength from the edge of the horn.

In the Result palette, Slice section, set the Independent axis to X posi-
tion. In the Fixed section, set the Y position to 100 mm and Z position to
460 mm. Unselect the X and Z checkboxes, so that only the Y component
is selected.

To add the second trace to the graph, select the Trace tab of the Cartesian contextual
tab. Click the Duplicate icon. (We could also have added the second trace from the

ribbon in the same way as the first trace.)

With the trace NearField1_1 selected in the Result palette, unselect the
Y and select the X component in the Quantity section. This will result in
only the Ex component of the field being displayed.

Over most of the aperture Ex is much smaller than Ey . It is therefore
recommended to set the vertical axis to dB. Select both traces and check
the dB checkbox in the Quantity section.

The minimum and maximum values for the vertical axis may be changed
by selecting the Display tab of the Cartesian contextual tab. Click the Axis
settings icon (Axes group) which will launch the Axis settings (Cartesian
graph) dialog.
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On the Axis settings (Cartesian graph) dialog select
the Vertical tab. Unselect the Automatically deter-

mine the grid ranges checkbox. Set the Minimum value of
the vertical axis to −20 and the Maximum value to 40.

Settings related to the format of
the font, colour and line style,
may be modified on the Format
tab.

1.11 Far field results

The far fields on a full sphere were requested in the solution control phase of this example. This
section explains the procedure to plot these results in a 3D view and on a polar plot.

In order to display the results in the 3D view, the 3D view must be the active
window. Select the 3D view window. The near field result currently displayed in
the 3D view can be hidden by clicking the eye icon next to the trace NearField1
in the Result palette.

When a result is hidden, a closed eye icon next to the result will indicate that it
is hidden.
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Select the Home tab and click the Far field icon (Add results
group). From the dropdown list select FarField1. The annota-

tion can be added by holding down<Ctrl><Shift> and left-clicking
when the annotation is displayed in the desired location.

Note that the fields are immediately displayed in the 3D view. In the
Result palette set the Quantity to Gain. Also check the dB checkbox
to set the scale to dB.

The size of the far field compared to the geometry size can be changed by selecting the
Result tab of the 3D View contextual tab. Click the Size icon (Rendering group) and select

the Custom... option from the dropdown list. Specify the size as 70%.

Far field radiation patterns are often displayed on 2D polar graphs. Since full 3D data is
requested in this simulation, 2D cuts can be extracted. To create a new polar graph, click

the Polar icon (Home tab, Create new display group). Click the Far field icon (Home tab, Add
results group) and from the dropdown list select FarField1. In this case it is requested that the
far field gain be plotted in the YZ plane on a polar graph. This corresponds to plotting the data
with respect to θ at a constant value of φ = 90◦.

In the Result palette, Independent axis section, select Theta (wrapped).
Select the value for Phi as 90 deg (wrapped).

Due to the sampling chosen when the calculation was requested, the
wrap option must be selected to complete the pattern. Set the Quantity
to Gain and select the dB checkbox.
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1.12 Closing remarks

This introductory example has shown aspects of the user interface of FEKO, from pre-processing
through to post-processing, using an existing model of a horn antenna supplied with the Altair
FEKO installation. The next example takes the user through the process of creating the geometry
and also shows how to model dielectric regions.

July 2017 FEKO Getting Started



CREATING MODELS IN CADFEKO 2-1

2 Getting started: Creating models in CADFEKO

2.1 Example overview

This example uses a completed model to familiarise the user with model creation in CADFEKO. It
is intended for users with no or little experience with CADFEKO. In this example no electromag-
netic solution is performed and no results are presented – this example illustrates the creation
of models from geometry parts, the combining of primitives and transforming a primitive to a
different location in the model. This example does not use the fastest, most effective way to
create the particular geometry, but instead illustrates the tools available in CADFEKO that allows
users to create complicated geometrical structures.

Figure 2-1 shows an illustration of the geometry that is created in this example.

Figure 2-1: Illustration of the geometry created in this example.

2.2 Before starting the example

Before starting this example, please ensure that the system satisfies the minimum requirements
before starting. A user should also ascertain whether the topics presented in this example are
relevant to the intended application and FEKO experience level.

The topics demonstrated in this example are:

• Launching CADFEKO

• Creating geometry from primitives

• Combining geometry to create more complicated objects (union, sweep, subtract)

• Using workplanes, snapping and moving objects in and out of operators

• Finding and fixing suspect items

• Setting material properties

• Relocating objects
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The requirements for this example are:

• FEKO 2017.2 RELEASE should be installeda with a valid licence.

• It is recommended that the demo video be watched before attempting this example.

• This example should not take longer than 40 minutes to complete.

aSee the FEKO Installation Guide to install Altair FEKO.

While working through this example, the steps should be followed sequentially, otherwise expla-
nations may seem to be out of context.

The model referred to in this example can be found in the

examples/GetStarted_models/Project2-Models_in_CADFEKO/Model_creation.cfx

directory of the Altair FEKO installation or downloaded from our website.

2.3 Starting CADFEKO

The first step in every FEKO solution is the construction of the model geometry. The geometry
is created using the CAD component, CADFEKO. The CAD model is stored in a *.cfx file. Start
CADFEKO by pressing the Windows Start button, typing ‘CADFEKO’ and running the application
from the list of filtered options. Click the Create a new model link on the start page.

2.4 Building a horn

First the horn will be created. It consists of a cube and a flare that have been unioned and the
excess faces removed. The cube is not constructed using the cuboid primitive, but rather created
using a rectangle and the path sweep operator.

Add variables

Any variables required to build the model can now be defined. Parametric models can be created
by using variables. It is the recommended construction method, but it is not compulsory.

In the model tree is a list of predefined variables. Three mecha-
nisms are available to add variables to the model:

On the ribbon, from the Variable icon on the Construct tab
(Define group).

On the model tree, from the Add menu at the top of the
Construction tab and Configuration tab.

A context menu (right-click menu) is also available on the Variables
group in the tree.
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Variables are created by entering a variable name and expression and clicking the Add button
(to keep the dialog open for adding more variables) or Create (to add the variable and close the
dialog). A short comment for the variable can be added to the Comment field.

Add the following variables (and optionally the comments):

Name Expression Comment

Width 1 Width of rectangle
Length 1 Length of rectangle
BottomDepth 1 Bottom depth of flare
BottomWidth 1 Bottom width of flare
FlareLength 1 Length of flare
TopWidth 2 Top width of flare
TopDepth 2 Top depth of flare

Add a workplane

We will now create a custom workplane and set it to the
default workplane.

On the Construction tab, right-click Workplanes and select Add
workplane from the context menu. As indicated in the context
menu, it is also possible to use the <F9> keyboard shortcut to cre-
ate a new workplane.

Below the Rotate workplane groupbox, click once the mid-
dle icon indicating a rotation about the V axis. Note how

the entries for the U, V and N vector are modified accordingly.
Click the Create button.

Workplanes are not required that often during construction, but
in certain cases they can save time.

The default workplane is used when creating new geometry
primitives. For this example we want the new workplane to be
the default workplane.

Right-click Workplane1 to open the workplane context menu.
Select Set as default from the context menu. The default work-
plane will be indicated by the text [Default] in the model tree.
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Create rectangle primitive

The next step will be to create a rectangle. Ensure that
the Construct tab is selected and click the Rectangle icon

(Create surface group) and set the definition method to Base cen-
tre, width, depth.

Set the Width equal to Width and the Depth equal to Length.
Click the Width (W) field to make it active. An active field al-
lowing point-entry, is indicated by a yellow background. These
variables may either be entered by pressing <Ctrl><Shift> and
left-clicking the variable in the model tree (point entry) or by
using keyboard input.

Note that default values for primitives are given to enable users
to view a preview of the primitive. These values are to be set by
the user to the desired value. Click the Create button to create
the rectangle.

Create line primitive

We need to create a line so that we can sweep the rectangle along
the line to create the cuboid.

Create a line by clicking the Line icon (Create curve group).
Set the Start point to (0,0,0) and the end point to (0,0,-1).

Click the Create button.

Note that the previously defined workplane is used since it has
been set as the default workplane.

Sweep the rectangle along the line

A cuboid will now be created by sweeping the rectangle along
a path (the line that was created). The Cuboid primitive would

usually be used, but for demonstrative purposes, the sweep operation is
utilised. Select Rectangle1 in the tree, note that the Path sweep icon in
the Extend group is now enabled. Click the Path sweep icon.

The Create path sweep dialog will be displayed, requesting that the path
to sweep along is to be selected. Click Line1 in the tree.
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A dialog will be displayed asking the following infor-
mation from the user: Alignment, Twist angle and
Scale factor. Use all the default values for the exam-
ple, but the user is encouraged to modify the settings
and to investigate its effect on the preview in the 3D
view. Click the Create button.

Create flare primitive

Open the Create flare dialog by clicking the Flare
icon (Create solid group). Set the Definition

method to Base centre, width, depth, height, top width,
top depth. The use of defined variables are optional.
Alternatively, the user may enter values instead of de-
fined values, although parametric models are the pre-
ferred methodology for CAD models. These values or
the defined variables may be modified at any time. The
model will then automatically be updated.

Set the flare dimensions as follows:

Dimension Value

Base centre (0,0,0)
Bottom width BottomWidth
Bottom depth BottomDepth
Height FlareLength
Top width TopWidth
Top depth TopDepth

These defined variables may also be entered into their
respective fields by pressing <Ctrl><Shift> and left-
clicking the defined variable in the tree, under Vari-
ables.

The model should look as shown in the figure, just before the
flare is created by pressing the Create button. Click the Create
button.
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Union the flare and the cuboid

The created flare and swept rectangle now need to be unioned. Note that in CADFEKO the Union
operation is used to define connectivity between parts. Parts that touch, but are not unioned, are
not considered to be physically connected and will not produce the correct mesh.

Select the flare and the cuboid (named Pathsweep1) in the
tree and click the Union icon (Modify group). Note that it is

possible to do a multi select of objects in the model tree (using the
<Ctrl> and/or <Shift> keys while selecting).

Tip: The keyboard shortcut for the Union operator is <U> and is
worth memorising since it is used quite often.

Remove redundant geometry faces

The next step will to be delete the faces
set between Flare1 and Pathsweep1.

The visualisation of the respective faces will
be improved by setting the opacity of the ge-
ometry. Select the Display options (3D View
contextual tab) and click the Opacity icon
(Style group) and select for example 40%
from the dropdown menu.

Select Union1 in the tree. In the details tree, under Faces, find the
face between the flare and the cuboid as shown in the figure. Right-
click the respective face and select Delete from the context menu. Also
delete the outer face of the flare.

Note that deleting the faces automatically changes the region proper-
ties from PEC (solid) to free space (shell).

Displayed in the image are the faces that are to be deleted.

July 2017 FEKO Getting Started



CREATING MODELS IN CADFEKO 2-7

Set the Opacity back to 100% again. The horn should now look as dis-
played.

2.5 Add a feed pin to the horn

The next part is to add a wire feed for the model. We will not add the port or the source, but this
section does illustrate how a wire (or any other geometry) can be added to an existing union.
Set the Opacity back to 40% again to allow improved visualisation for the next step.

Create the wire

Create a line by clicking the Line icon. Click the Workplane
tab. Hold down <Ctrl><Shift> whilst moving the mouse

cursor over the 3D model. Notice that special snapping points to
which the new workplane can be snapped to will be indicated by
blue dots. Although only special snapping points are indicated by
blue dots, it is possible to snap to any point in the 3D view.

Snap the workplane to the centre of the bottom face of the cuboid.

By using the icons in the Rotate workplane group, rotate
the line’s workplane until the values illustrated in the im-

age are entered into the U, V and N vector fields (rotate 90 de-
grees around the N axis for this specific workplane orientation).

Click the Geometry tab. Set the Start point as (-0.25,0,0) and
the End point as (-0.25,0,0.25). This will be the feed element.
Modify the Label field to Feed. Click the Create button.

Set the Opacity back to 100% again

Union the feed wire with the horn

Select the Feed in the tree and drag it onto Union1 (also in the tree).
A context menu will be displayed, select Move into.
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After the Feed was moved into the Union, the tree should now look as
shown in the figure.

2.6 Selection in the 3D view

The following steps are not required to build the model, but it illustrates how selection in CAD-
FEKO works.

Move the mouse cursor to one of the inside faces of the flare. Left-
click the face and notice that the face is highlighted in yellow.

When left-clicking the face again, note that the entire model is high-
lighted in yellow. The default CADFEKO selection method (Auto)
cycles through the applicable selection type when repeatedly left-
clicking the model. The first left-click highlighted the face of the
flare. The second left-click highlighted the flare part.

In CADFEKO, the selection type may be modified by selecting
the Tools tab and clicking the Selection type (Selection group).
The Auto selection type is the default selection type in CAD-
FEKO. Continuously left-clicking a part of the model will cycle
through the applicable selection types and highlight the ele-
ment.

A second method for modifying the selection type is by means of the status
bar. Click the Selection toolbar and select the required selection type from
the menu.
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2.7 Cut a hole in a face

Holes in faces and regions are created by first creating the geometry that should be removed and
then subtracting the one part from another part.
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Create and place the ellipse

Create an ellipse by clicking the Ellipse icon (Create surface group). Select the workplane
tab. The workplane will now be placed on the underside of the flare by snapping it to the

surface of the flare.

The fields on the workplane tab should have a yellow background
(click one of the origin fields if this is not the case). Press
<Ctrl><Shift> and move the mouse cursor over the flare. Note the
change in the Origin, U and V vector fields as the mouse cursor is
moved. Special snap points will be indicated by blue dots.

While holding down <Ctrl><Shift> on the keyboard, move the
mouse around until the local workplane is orientated as displayed
in the image.

Move the mouse cursor close to an edge, then to the face centre. Now move to a different edge
and return back to the face centre. Note how the history of where the mouse cursor was moved
to the face centre, affects the orientation of the workplane.

Click the Geometry tab and set the dimensions
as follows:

Dimension Value

Radius (U) 0.3
Radius (V) 0.2

Click the Create button.

Subtract the ellipse from the horn

Select Ellipse1 in the tree and right-click. From
the context menu, select Apply→ Subtract from
as indicated in the image. It is also possible
to launch the subtract operator from the ribbon
(Construct tab).

A dialog, asking for the object to subtract from
will be displayed. Select Union1 in the tree.

The object from which was subtracted (the target), will be indicated by
a T next to Union1 in the tree (shown in figure).
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2.8 Create a dielectric object with metal faces

Creating dielectric objects in CADFEKO is simple. The following section will illustrate how a
dielectric object is created. We will also set a subset of the faces bounding the dielectric object as
metal.

Add a dielectric

Add a new dielectric medium from the Media Library to the
model by selecting the Construct tab. Click the Media menu

button (Define group) and select Media Library from the dropdown
menu. Alternatively one can also right-click the Media entry in the
tree and select Media Library from the dropdown menu.

The dielectric object will be defined as consisting of the
dielectric material Teflon. In the Filter editbox, type
Teflon. At the bottom of the dialog, click Add to model to
add the dielectric from the library to the CADFEKO model.

After the dielectric is added to the CADFEKO model from the media
library, it will be displayed in the tree under Dielectric group. The
media library can now be closed.

Reset the global workplane

Next, set the Global XY workplane as the default workplane. Right-click the Global XY and
select Set as default from the context menu.
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Create a dielectric cuboid

Create a cuboid by clicking the Cuboid icon.

Select the Base corner, width, depth, height definition
method and set the following dimensions:

Dimension Value

Base corner (0,4,0)
Width 5
Depth 5
Height 5

Select the Cuboid1 part in the tree.
Now right-click the region in the de-
tails tree and open the Properties
dialog. Set the Region medium to
Teflon.

Change faces to metal

Select Cuboid1 in the tree and select its corresponding front face
(the face at X/U=5) and upper face (the face at Z/N=5) in the de-
tails tree. Right-click and select Properties from the context menu.
At the Face medium, set the Face type to Perfect electric conductor.
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2.9 Position the horn on another object

The face centre of the horn will now be
aligned on the front upper edge of the

cuboid.

Click Subtract1 in the model tree and select the
Transform tab. Click the Align icon (Transform
group) to display the Align dialog.

Place the Source workplane by holding down the
<Ctrl><Shift> keys to snap to the centre of the
back face of the horn. Click one of the Origin
fields in the Destination workplane group to acti-
vate (indicated by yellow background) the desti-
nation workplane. The destination workplane is
set on the top and nearest edge of the cuboid.

The cuboid should be placed at an angle of 45
degrees to the cuboid. Rotation of the flare may
be accomplished by rotating around the U axis
and/or V axis and/or the N axis, depending on
the direction of the original placement of the
source workplane. For the rotation of 45 degrees,
enter the 45 in the respective axis and press the
rotation icon.

Click the OK button to apply the transform and
close the dialog.

Union Cuboid1 and Subtract1 by selecting them both in the tree and clicking the Union
icon.

2.10 Closing remarks

This introductory example has shown aspects of model creation in CADFEKO. The next example
takes the user through the process of using multilayer planar substrates, using symmetry planes
to reduce the required resources, using adaptive frequency sampling to obtain continuous data
and viewing the input impedance in POSTFEKO.

Note again that this was not a practical example that can be simulated, but rather an example
that illustrates the power of CADFEKO when creating complex models. The other examples are
practical examples that can be simulated.
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3 Getting started: A patch antenna

3.1 Example overview

A patch antenna designed to operate close to 2.8 GHz will be modelled in this example. The
model is first constructed as a patch on an infinitely large substrate since it is quick to create
and to simulate. The antenna is then adapted so that it has a finite substrate, making it a more
realistic model. Figure 3-1 is an illustration of the patch with a finite ground that we are going
to construct.

Figure 3-1: Illustration of a patch on a finite substrate.

3.2 Before starting the example

Before starting this example, please ensure that the system satisfies the minimum requirements
before starting. A user should also ascertain whether the topics presented in this example are
relevant to the intended application and FEKO experience level.

The topics demonstrated in this example are:

• Use of a multilayer planar substrate.

• Modelling of a finite sized dielectric substrate.

• Comparison of simulation time and resource requirements using different modelling tech-
niques.

• Usage of symmetry planes to reduce the required resources.

• Adding a voltage source to a wire segment.

• Using adaptive frequency sampling to obtain continuous data.

• Viewing the simulated input impedance in POSTFEKO.
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The requirements for this example are listed below.

• FEKO 2017.2 RELEASE or later should be installeda with a valid licence.

• It is recommended that the demo video be watched before attempting this example.

• This example should not take longer than 60 minutes to complete.

aSee the FEKO Installation Guide to install Altair FEKO.

While working through this example, the steps should be followed sequentially, otherwise expla-
nations may seem to be out of context.

The models referred to in this example can be found in the

examples/GetStarted_models/Project3-Patch_Antennas

directory of the Altair FEKO installation or downloaded from our website.

3.3 Patch on infinite substrate

A small patch antenna on an infinitely large multilayer substrate is constructed in CADFEKO
before running the FEKO solver. The results from the FEKO solver are then viewed in POSTFEKO.

The first step in every FEKO solution is to construct the model. Start by launching CADFEKO
which then opens with the start page. Click Create a new model to create a new model. The
model is created using CADFEKO and stored in the *.cfx file.

3.3.1 Creating the model

The model creation steps that we are going to perform can be summarised as:

• Set the model unit to millimetres.

• Add variables that define the model geometry and material parameters.

• Add a new dielectric medium type to the model.

• Create the patch.

• Create the planar multilayer substrate.

• Create the feed pin to excite the patch.

• Union the geometry.

• Add a port and voltage source on the feed pin.

• Set the solution frequency.

• Set the symmetry plane.

July 2017 FEKO Getting Started



PATCH ANTENNA PROJECT 3-3

• Mesh the model and run the FEKO solver.

CADFEKO should now be open with an empty model. Let’s start construction of the model.

Set the model unit

The default unit length in CADFEKO is metres. Since the patch
that we are going to build is small, we should set the model unit

to millimetres. All dimensions can then be entered in millimetres.

To set the model unit, select the Construct tab and click the Model unit
icon (Define group). Select Millimetres and close the dialog by clicking
the OK button. The Unit section shown on the status bar in the far lower
right corner of the CADFEKO window also opens this dialog.

Define variables

The model tree contains a list of predefined variables. To
add variables to the list, right-click the Variables heading in

the tree and select Add variable in the context menu or use the ap-
propriate button from the ribbon (Construct tab→ Define group).

Variables are created by entering a variable name and expres-
sion and then clicking the Add button. A short comment for
the variable can be added to the Comment field. The includ-
ing of comments for variables is optional. Add the following
variables:

Name Expression

freq_max 3.0e9
freq_min 2.6e9
lambda_min c0/freq_max*1000
patch_d 33.2
patch_w 46.8
substrate_er 2.2
substrate_h 2.87
feed_dist 8.9
feed_rad 1.3/2

After all the variables have been created, click the Close button to close the dialog. The comment
of a variable is displayed when hovering with the mouse over the variable name (if available).
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Define a dielectric medium

Media can either be defined by selecting the Construct tab
and clicking the Media icon (Define group) or by means of

the tree. Right-click Media in the Construction tree and select Di-
electric medium to create a new dielectric medium definition. All
dielectric media must be created before it can be used in the model.

For the patch, we have selected to simulate
the substrate as a lossless material with a rel-

ative dielectric constant of 2.2.

Select the Dielectric modelling tab and set the Defi-
nition method to Frequency independent.

We have already created a variable for the relative
permittivity, so simply enter substrate_er in the
Relative permittivity field. Keep the default value
of 0 for the Dielectric loss tangent and enter the label
name substrate into the Label field.

Create the patch

Ensure that the Construct tab is selected and click the
Rectangle icon (Create surface group). Under the Defini-

tion methods, select Base center, width, depth.

Enter the dimensions as indicated in the table.

Field Value

Width patch_w
Depth patch_d
Label Patch

Click the Create button to create the patch and to close the di-
alog. Variables and named points can be entered by pressing
<Ctrl><Shift> and clicking with the mouse the respective vari-
able or named point in the tree.

Click the Zoom to extents icon (View tab → Zooming
group) to show the entire geometry. Alternatively, press

<F5> on the keyboard.
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Define the infinite ground plane

Now we add the substrate and the ground
plane. Click the Planes/Arrays icon on the

Construct tab of the ribbon (Structures group)
and select Plane/ground from the dropdown
menu.

Select Planar multilayer substrate as the ground
medium. For this example we require only a PEC
ground plane for Layer 1. (These settings are nor-
mally already set in the dialog by default.)

For Layer 1 define a PEC ground plane with a
thickness of substrate_h and of medium substrate.
Note the Media preview on the Plane / ground
dialog. Click the OK button to create the infinite
plane and close the dialog.

Create the feed pin

Click the Line icon (Create curve group) to create the feed
pin. We have already created variables for the distance of

the feed pin from the edge of the patch. Simply enter the values
in the table below.

Corner Coordinate Expression

Start point U 0
V -patch_d/2 + feed_dist
N -substrate_h

End point U 0
V -patch_d/2 + feed_dist
N 0

Enter Feedpin in the Label field. Click the Create button to close
the dialog.

Union the pin and the patch

The two geometry parts have to be unioned so that the segment
end points coincide with mesh vertices when the mesh is cre-

ated later. Select the two geometry parts in the tree (using <Ctrl>)
and click the Union icon (Modify group).

Add a port for the source

After creating the pin, we have to add a port to the feed pin. A port is
simply a connection point for loads and sources. Select Union1 in the
tree and its corresponding wire in the details tree.
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Select the Source/Load tab and click the Wire port icon
(Ports group).

The Create wire port dialog is displayed and the edge field is
automatically populated with the correct edge. (The name of
the Edge may differ.) Select Middle to place the port in the
middle of the wire.

Click the Create button to create the wire port and close the
dialog.

Add a voltage source

We are now going to add a voltage source to the port.

Ensure that the Source/Load tab is selected, click the Volt-
age source icon (Sources on ports). The values on the Add

voltage source dialog do not have to be changed.

Click the Create button to create the voltage source and close the
dialog.

Adding the voltage source should change the tab to the Configu-
ration tab, as opposed the Construction tab where we created the
geometry and the port. Sources, loads and the frequency settings
are set on the Configuration tab.

Set the simulation frequency

Click the Frequency icon (Settings group) to set the frequency range of the simulation.
Select the Continuous (interpolated) range and enter the start and end frequency as listed

in the table.

Field Value

Start frequency (Hz) freq_min
End frequency (Hz) freq_max

Also note that variables can be entered by positioning
the cursor in the respective edit field and then press
<Ctrl> <Shift> and clicking the desired variable.
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Define model symmetry

The model has magnetic symmetry at X=0. The required resources
(memory and time) can be reduced by allowing the solution ker-

nel to utilise symmetry. Note that this step is optional and the user is
encouraged to remove symmetry later and to compare the difference in
solution time and memory usage.

Select the Solve/Run tab and click the Symmetry icon (Solution settings
group). Set Magnetic symmetry at the X=0 plane. Click the OK button
to close the dialog.

Mesh the model

The model has now been created and all that is left is to mesh
the model before we can simulate and view the results.

Select the Mesh tab and click the Create mesh icon
(Meshing group) or use the <Ctrl><M> shortcut to open

the Create mesh dialog.

Set the Mesh size to Standard and the Wire segment radius to
feed_rad. Click the Mesh button to create the mesh and close
the dialog.

Save the model by clicking the Application menu icon and selecting from
the menu Save as... and entering a file name. The shortcut key combina-

tion to save is <Ctrl><S>.

Validate the model

The model should now be computational electromagnetically (CEM) validated. The purpose of
this validation is to ensure that errors regarding the Frequency, Geometry, Mesh and Solution
are found and corrected before the FEKO solver is run.
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Run CEM validate by
selecting the Solve/Run

tab and clicking the CEM Vali-
date icon (Validate group).

When any errors are found, an
error can be selected resulting
in a short description of the
error being shown in the Er-
ror/Warning details of the se-
lected item window.

An example of the CEM vali-
date dialog is displayed in the
image. A number of errors and
warnings are indicated to illus-
trate the feedback that can be
expected.

Click the Close button to close
the dialog.

Simulate the model

Run the FEKO solver by selecting the Solve/Run
tab and clicking the FEKO solver icon (Run/Launch

group).

It can also be launched by using the <Alt><4> shortcut key or by
clicking the FEKO solver icon on the Quick access toolbar which include
the application launchers.

The FEKO solver is launched in a window displaying calculation in-
formation as well as any warning and error messages. No warning
or error messages should be generated if all the steps have been
followed correctly. Once the calculation has completed, click the
OK button to close the message window.

3.3.2 Viewing the results

The model creation and simulation process is complete. We can now use POSTFEKO to view
the real and imaginary input impedance and the reflection coefficient of the patch antenna. The
steps are summarised below.

• Create a Cartesian graph.

• Display the real part of the input impedance over the entire frequency range.

• Add another trace to display the imaginary part of the input impedance on the same graph.
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• Change the line colour, line style and line weight of the traces if required.

• Add another Cartesian graph to display the reflection coefficient of the antenna.

Run POSTFEKO by using the <Alt><3> shortcut key, application launchers or from the
CADFEKO ribbon. POSTFEKO opens by default with a single 3D window that displays the

geometry of the model.

Display real and imaginary source impedance

Click the Cartesian icon (Create new display group on the Home tab) to create a blank
Cartesian graph where traces can be added.

Click the Source data icon (Home tab, Add results group) and select VoltageSource1 from
the dropdown list.

On the Result palette (to the right of the POSTFEKO window), Traces section,
select the trace VoltageSource1. Set the Quantity to Impedance. Select the
Real part of the impedance in the Quantity section.

Select the Trace tab on the Cartesian contextual tab. Click the Dupli-
cate trace icon (Manage group). A duplicate trace is now created with

the label VoltageSource1_1. The Duplicate trace option is also available on
the context menu and <Ctrl><K> keyboard shortcut.

On the Result palette, select the second trace (VoltageSource1_1) in the
Traces section. Set the impedance as Imaginary in the Quantity section.

The graph should now contain two traces. Select one of the two traces by either clicking the trace
on the graph or selecting the trace in the Traces section in the Result palette. A selected trace
will be indicated by rectangular selection handles.

On the Format tab (Cartesian contextual tab), click the Line colour icon (Line group) and
select a colour of your choice from the dropdown menu. Similarly, the Line style and Line

weight may be changed.

Display the reflection coefficient

Add another Cartesian graph by selecting the Home tab and clicking the Cartesian icon. A
second graph is now available with the label Cartesian graph2.
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Click the Source data icon (Home tab, Add results group) and
select VoltageSource1 from the dropdown menu. The reflection

coefficient of the patch antenna is displayed on the graph Cartesian
graph2.

The default display for reflection coefficient is linear, but the reflection
coefficient is better viewed on a dB scale.

On the Result palette (Quantity section), select dB by checking the dB
checkbox.

Save the model

Save the POSTFEKO session file to ensure the view is maintained for viewing
later. The default name and location for the POSTFEKO session file should be
used when saving. The session file may be saved by clicking the application
menu icon and selecting the Save option from the menu.

The patch antenna example with an infinite ground plane has been completed. In the next section
we change the model to be more realistic by simulating a patch antenna with a finite size ground
plane.
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3.4 Patch on finite substrate

The model of the patch is now going to be extended to a patch on a finite substrate. This model
is closer to a physical model, but calculation time is increased slightly.

New concepts are introduced such as:

• mesh refinement on edges.

• creating a dielectric region.

• setting specific faces as metallic.

3.4.1 Extending the model

Extending the model in CADFEKO requires the following steps:

• Remove the previously defined multi-layer substrate.

• Define more variables.

• Create a new substrate with specified dimensions.

• Union the geometry.

• Set the ground and patch face to metallic.

• Mesh the model and validate the resulting mesh.

• Run the FEKO solver.

Leave POSTFEKO open and switch to CADFEKO. We will start by removing the infinite plane from
the existing model.

Remove the infinte ground

Select the Construct tab and click the Plane / ground icon (Structures group). On the
Plane / ground dialog select No ground (homogeneous free space medium). Click the OK

button to close the dialog. This removes the infinite plane.

Define variables

Add two new variables to the model. To add the variables
to the list, right-click the Variables heading in the tree and

select Add variable in the context menu.

Variables are created by entering a variable name and expression
and then clicking the Create button. Add the following variables:
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Name Expression

substrate_w 80
substrate_d 50

After all the variables have been created, click the Close but-
ton to close the dialog.

Create finite substrate

Click the Cuboid icon (Construct tab, Create solid group)
and fill in the fields as listed in the table. Note that it is not

necessary to create variables when defining geometry. The values
can also be entered directly, but in this example we have already
defined the variables. Variables can also be entered by pressing
<Ctrl><Shift> and clicking with the mouse the variable in the
tree.

Field Value

U -substrate_w/2
V -substrate_d/2
N -substrate_h
Width (X) substrate_w
Depth (Y) substrate_d
Height (Z) substrate_h

Click the Create button to create the cuboid and close the dialog.

Ensure that the newly created cuboid is selected in the model tree.
Right-click the region in the details tree and select Properties to open
the Region properties dialog.

Set the Region medium to substrate. This is the sub-
strate dielectric medium that we created at the start of
the example.

Click the OK button to close the dialog.

Union the substrate and the patch

The two geometry parts have to be unioned so that the segment end
points coincide with mesh vertices. Select the two geometry parts
(using <Ctrl>) and click the Union icon.
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Set faces to metal

Clicking more than once on the same object cycles
through the CADFEKO selection types and thus it is
not required to change the selection type manually.

In the 3D view, continue to left-click the face of the
patch until it is highlighted in yellow. In the details
tree, right-click the highlighted face below the Faces
group and select Properties.

Set the Face medium to Perfect electric conductor
(PEC) and click the OK button to close the dialog.

This process of selecting the face and setting it
to PEC has to be repeated for the ground plane.
Rotate the model so that the bottom of the model
is visible. Select the face and set its properties to
PEC in the same way as we did for the patch.

Mesh the model

The model has now been created and all that is left is to mesh
the geometry before we can simulate and view the results.

Select the Mesh tab and click the Create mesh icon
(Meshing group) or use the quick mesh shortcut,

<Ctrl><Shift><M>, if the meshing settings have been previ-
ously defined.

Before we perform the simulation we should verify
that the model that we created is indeed what we
wanted to create. CADFEKO has several model vali-
dation tools and we are only going to use the mesh
colouring tools in this example.

The meshed patch should look similar to the image
(the medium colour will probably be different).
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Save, validate and simulate

Save the model. The key combination (shortcut) to save is <Ctrl><S>. Remember to
save often when creating models to prevent work being lost due to system failures.

Run the CEM validate by selecting Solve/Run tab and clicking the CEM validate icon
(Validate group).

Run the FEKO solver by selecting the Solve/Run tab and clicking the FEKO solver icon or
using the <Alt><4> key combination. A message window asking if the results should

be replaced may appear, click Yes to allow the solution kernel to calculate the new results. The
FEKO solver is launched in a window displaying calculation information as well as any warning
and error messages. No warning or error messages should be generated if all the steps have been
followed correctly. Once the calculation has completed, click the OK button to close the message
window.

3.4.2 Viewing the new results

The results of the simulation can be viewed in POSTFEKO after completing the simulation. Since
we have already created a POSTFEKO session for this project, all display windows are visible
without any changes. POSTFEKO automatically detects if the FEKO solver results have changed
and updates the session data.

3.5 Closing remarks

This example has demonstrated two ways to simulate a patch antenna excited with a pin such
as an SMA connector. Many concepts have been introduced in this simple example that are
applicable to models commonly created in CADFEKO.

The important factors to remember is the difference in solution time and the deviation in the
results. The model with an infinite substrate required fewer triangles to model and simulated
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faster than the model with a specified substrate size. The difference in the resonance frequency
is approximately 6.5% and would become greater if we were to decrease the substrate dimen-
sions further. It is important to always consider how well your model represents real life. The
correlation between the results of the two models should improve if the size of the finite substrate
is increased to better represent the infinite approximation.
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4 Getting started project: EMC coupling

4.1 Example overview

This example considers the coupling between a typical monopole antenna and a loaded trans-
mission line as shown in Figure 4-1. Both the antenna and the transmission line consist of wire
conductors (we refer to structures as wires when they are conducting bodies whose lengths are
significantly longer than their diameters).

50 mm

12 m2 m

12 m

diameter = 8 mm

diameter = 30 mm

P = 1 W
in

~

R = 1kW

Figure 4-1: Sketch of the model.

4.2 Before starting the example

Before starting this example, please ensure that the system satisfies the minimum requirements
before starting. A user should also ascertain whether the topics presented in this example are
relevant to the intended application and FEKO experience level.

The topics demonstrated in this example are:

• Using a perfectly conducting infinite ground plane.

• Loading of a wire with a complex impedance.

• Adding a voltage source to a wire.

• Using adaptive frequency sampling to obtain continuous data.

• Viewing the simulated input impedance and currents in POSTFEKO.

The requirements for this example are listed below.

• FEKO 2017.2 RELEASE or later should be installeda with a valid licence.

• It is recommended that the demo video be watched before attempting this example.

• This example should not take longer than 70 minutes to complete.

aSee the FEKO Installation Guide to install Altair FEKO.
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The models referred to in this example can be found in the

examples/GetStarted_models/Project4-EMC_Coupling

directory of the Altair FEKO installation or downloaded from our website.

4.3 Creation of the geometry in CADFEKO

The first step in every FEKO solution is to construct the model. Start by launching CADFEKO
which opens with the start page. Click the Create a new model icon.

Save the model in a new directory where it can later be found for further experimentation.
CADFEKO saves its models as *.cfx files.

The model creation steps that we are going to perform can be summarised as:

• The monopole is created as a single line element with a local wire radius.

• The transmission line is created as a polyline element.

• The ground plane is defined using an infinite reflection ground.

• Add a port and voltage source on the monopole.

• Set the radiated power of the model.

• Add a port and a complex load to the transmission line.

• Set the solution frequency.

• Mesh the model and run the FEKO solver.

Create the monopole

The first step is to draw the monopole along the positive
Z axis. Select the Construct tab and click the Line icon

(Create curve group). A single line 12 m long is created along
the Z axis.

After creating this part, select the View tab and click the
Zoom to extents icon (Zooming group) or press the <F5>

shortcut key. Note that it may be difficult to see the monopole as
a result of the overlap with the Z axis.

The display of the global axis can be disabled by selecting
the Display options on the 3D View context. Click the Main

axes icon (Axes group) to toggle the display on and off for the
main axes.
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Because the monopole and transmission line wires have differ-
ent radii, the wire radius for this model cannot be set globally

during meshing. The global setting will be set for the transmission
line, so a local radius needs to be specified for the monopole. The
wire radius is set on the Edge properties dialog. To open this dialog,
select the line in the tree, expand the Wires in the details tree and
select the wire. Select the Properties option from the context menu.

The wire radius is set by checking the Local wire radius check-
box and entering 0.015 in the available field.

The icon next to the edge will change in the detail tree, indicating a locally
specified radius.

Create the transmission line

The transmission line is created using a polyline curve. To
create it, select the Construct tab and click the Polyline icon

(Create curve group). By default, two corners are shown. Click
the Add button (next to the Remove button) twice to add the
additional corners.

The transmission line is created along the Y axis by defining the
specified corners.

U V N

Corner 1 0 2 0
Corner 2 0 2 0.05
Corner 3 0 14 0.05
Corner 4 0 14 0

Select the View tab and click the Zoom to extents icon
(Zooming group) to get the structure to fit inside the 3D

view (or press <F5>).
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Define the infinite ground

To create the infinite ground plane, a Perfect electric
(PEC) ground plane at Z=0, is added. To do this, select

the Planes/Arrays menu button (Structures group).

Click Perfect electric (PEC) ground plane at Z=0.

This method of modelling large ground planes is
an efficient compared to discretising a finite sized
ground plane.

Define the ports

The next step is to define the ports, sources and loads for the model.

The first port will be created on the monopole for the source. To
create this port, select the Line1 part in the tree and then select the
wire element (Wire1) in the details tree that is associated with Line1.

Select the Source/Load tab and click the Wire port icon
(Ports group).

The default port settings (start of line, segment port) are used
for this model. Click the Create button to create the port and
close the dialog.

Ports may also be added via the details tree. The port
for the load on the transmission line will now be defined.
First select the correct edge (the vertical wire farthest from
the monopole) in the details tree, right-click and select
Create port in the context menu. Select Wire port from
the context menu.
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Care needs to be taken to ensure that the correct
edge is selected. (The 3D view shows a preview of
the port. It is indicated by a sphere with its centre
in green.) Again, the default settings can be used
for the port. Click the Create button to create the
port and close the dialog.

Add a source

A Voltage source is now applied to the first port. Select the
Source/Load tab and click the Voltage source icon (Sources

on ports group).

The radiated power must be 1 Watt for this example, but since
the input impedance for the monopole is not known, this can
not be set by changing the voltage. In the next step, the power
settings are changed to scale the radiated power. Therefore leave
the default voltage settings. Click the Create button to define the
voltage source and close the dialog.

Set the radiated power level

Once the source has been created, CADFEKO will change the tree
tab to the Configuration tab where sources, loads and power set-
tings can be modified.

To set the radiated power for the model, click the Power
icon (Settings group). In this case the radiated power

should be 1 Watt, so power losses as a result of source mismatch
are deducted before the 1 Watt is calculated. Select the Total
source power (no mismatch) option. Enter a source power of
1 Watt and click the OK button.
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Add a complex load

The resistive load must be added to the second port. Se-
lect the Source/Load tab and click the Add load icon

(Loads/networks group). Change the port for the load to Port2
and the real part of the impedance to 1000 Ω. Click the Create
button to create the load and close the dialog.

The remaining step in the process is to specify the frequency range of interest.

Set the simulation frequency

To set the frequency range for the analysis, se-
lect the Source/Load tab and click the Frequency

icon (Settings group). For this example, continuous fre-
quency sampling is used where FEKO automatically de-
termines the frequency sampling for optimal interpola-
tion. Select the Continuous (interpolated) range option
and enter the provided start and end frequencies.

Frequency

Start frequency 1 MHz
End frequency 30 MHz

Mesh the model

Now the model must be meshed. To create the mesh, select the
Mesh tab and click the Create mesh icon (Meshing group) or use
the shortcut key <Ctrl><M>.

Set the Mesh size to Standard. The global Wire segment radius
is set to that of the transmission line, which is 4 mm. As the
model unit is in metre, enter a value of 0.004. (The radius of the
monopole was set locally, and local sizes overwrite global sizes.)

July 2017 FEKO Getting Started



EMC COUPLING PROJECT 4-7

4.4 CEM validation

The model should now be computational electromagnetically validated. The purpose of this
validation is to ensure that errors regarding the Frequency, Geometry, Mesh and Solution are
found and corrected before the FEKO solver is run.

Run the CEM validate by selecting the Solve/Run tab and clicking the CEM validate icon
(Validate group).

When any errors are found, the error can be selected resulting in a short description of the error
being shown in the Error/Warning details of the selected item window.

4.5 Obtaining a solution

After completing the model preparation, the solver should be invoked to calculate the results.
No requests were added to this model since impedance current information are automatically
calculated for all voltage and current sources. A prompt will appear asking whether the model
should be saved before the solver executes.

Run the FEKO solver by selecting the Solve/Run tab and
clicking the FEKO solver icon (Run/Launch group).

It can also be launched by clicking the FEKO solver icon on the
Application launchers at the top right of the CADFEKO window. A
window will open, giving step by step feedback as the simulation
progresses. The solver will use approximately 39 frequency samples
in the band. (Note that this value can vary slightly.)

4.6 Visualisation of results

The model creation and simulation process is complete. We can now use POSTFEKO to view the
results.

Ensure that CADFEKO is the active application. Run POSTFEKO by using the <Alt><3>
shortcut key, application launchers or from the CADFEKO ribbon. POSTFEKO opens by

default with a single 3D window that displays the geometry of the model.

Display the load current

To show a graph of the current in the load on the transmission line, click the Cartesian
icon (Home tab, Create new display group) on the ribbon.

Click the Loads/networks icon (Home tab, Add results
group) and from the dropdown menu select Load1.
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Ensure that the trace Load1 is selected in the Result palette, Traces section.
Select the dB checkbox to change the scaling to dB in the Quantity section.

Display the source input impedance

We are also going to look at the input of the source on a new Cartesian graph.

Click the Cartesian icon (Home tab, Create new display group) to create a new Cartesian
graph.

Click the Source data icon (Home tab, Add results group) and select VoltageSource1 from
the dropdown list.

Ensure that the trace VoltageSource1 is selected. In the Quantity sec-
tion, select Impedance as quantity. Also select the Real real part of the
impedance.

Select the Trace tab on the Cartesian contextual tab. Click the
Duplicate trace icon (Manage group). A duplicate trace is now

created with the label VoltageSource1_1. The Duplicate trace option is
also available on the context menu and <Ctrl><K> keyboard short-
cut.

Select the trace VoltageSource1_1 and for the impedance select Imag-
inary.
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Select one of the two traces by either clicking the trace on the graph or selecting the trace in the
Result palette, Traces section. A selected trace will be indicated by rectangular selection handles.

On the Format tab (Cartesian contextual tab), click the Line colour icon (Line group) and
select a colour of your choice from the dropdown menu. Similarly the Line style and Line

weight may be changed.

4.7 Closing remarks

This example has shown the construction, configuration and solution of an EMC coupling prob-
lem. The problem description is a monopole antenna and transmission line on an infinite per-
fectly electric conducting ground plane. Coupling of current into the transmission line is shown
from 1 MHz to 30 MHz.
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5 Getting started: A waveguide power divider

5.1 Example overview

In this example the transmission and reflection coefficients of a waveguide power divider is
calculated at 9 GHz. The power divider has been designed to split the power equally between
the two output ports while minimising any power reflected back to the source port. The power
is split by placing a metal pin at the junction between the three ports. The waveguide geometry
(and instantaneous near field) is illustrated in Figure 5-1.

The model utilises symmetry to reduce memory requirements and to increase the calculation
speed.

Figure 5-1: Illustration of the waveguide power divider.

5.2 Before starting the example

Before starting this example, please ensure that the system satisfies the minimum requirements
before starting. A user should also ascertain whether the topics presented in this example are
relevant to the intended application and FEKO experience level.

The topics demonstrated in this example are:

• Using waveguide ports.

• Defining geometry and solution parameters in CADFEKO.

• Utilising symmetry to reduce the required resources (time and memory).

• Running the FEKO solution kernel.

• Viewing the results in POSTFEKO.
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The requirements for this example are listed below.

• FEKO 2017.2 RELEASE or later should be installeda with a valid licence.

• It is recommended that the demo video be watched before attempting this example.

• Working through this example should not require more than about 30 minutes.

aSee the FEKO Installation Guide to install Altair FEKO.

While working through this example, the steps should be followed sequentially, otherwise expla-
nations may seem to be out of context.

The models referred to in this example can be found in the

examples/GetStarted_models/Project5-Waveguide_Power_Divider

directory of the Altair FEKO installation or downloaded from our website.

5.3 Creation of the model in CADFEKO

The first step in every FEKO solution is to construct the model. Start by launching CADFEKO
which opens with the start page. Click Create a new model. The model is created using CADFEKO
and stored in the *.cfx file.

The steps that we are going to follow to create the model are:

• Set the model unit to millimetres.

• Define variables to parametrise the model.

• Create the power dividing pin.

• Create the waveguide sections.

• Move the geometry so that symmetry can be utilised.

• Set the symmetry planes to use.

• Add waveguide ports to the relevant faces.

• Add a source.

• Set the frequency of the solution.

• Add a near field request.
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Set model unit

The default unit length in CADFEKO is metres. Since the structure
that we are going to build is small, the model unit should be set to

millimetres. All dimensions will then be entered in the new model unit.

To change the model unit, select the Construct tab and click the Model
unit icon (Define group). Select Millimetres and close the dialog by click-
ing the OK button. The Unit section shown on the status bar in the far
lower right corner of the CADFEKO window also opens this dialog.

Define variables

Variables may be defined by selecting the Construct tab and
clicking the Variable icon (Define group).

Variables may also be defined via the tree. Right-click the Variables
group in the model tree (Construct or Configuration tab) and select
Add variable. A short comment for a variable can be added to
the Comment field. The inclusion of comments for variables is
optional. The comment of the variable is displayed when hovering
the mouse over the variable name (if available).

Create the following variables:

Name Expression

freq 9e9
lambda c0/freq*1000
pin_r 1
wg_h 10
wg_w 20
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Create cylinder (power dividing pin)

A cylinder will now be created. Select the Construct tab
and click the Cylinder icon (Create solid group). The di-

mensions and position for the cuboid are listed in the table below.

Group Field Expression

Base centre U 0
V 0
N 0

Dimensions Radius (R) pin_r
Height(H) wg_h

The variables, pin_r and wg_h, can be added by holding down
<Ctrl><Shift> and clicking the respective variables in the tree.
Leave the name Cylinder1 (default name) in the Label field. Click
the Create button to create the cylinder and close the dialog.
Click the Zoom to extents icon to fit the 3D display around the
geometry - alternatively press <F5>.

Create cuboids (waveguide sections)

Select the Construct tab and click the Cuboid icon (Create
solid).

Create a cuboid with the Base centre, width, depth, height defi-
nition method. The dimensions and position are listed below.

Group Field Expression

Base centre U 0
V 0
N 0

Dimensions Width (W) wg_w
Depth (D) 2*wg_w
Height(H) wg_h

Leave the name Cuboid1 (default name) in the Label field. Click
the Add button to create the cuboid, but leave the dialog open.
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Create a second cuboid with the dimensions and position
listed in the table below. Note that the Base corner, width,

depth, height definition method is specified and not the base cen-
tre as with Cuboid1.

Group Field Expression

Position U wg_w/2
V -wg_w/2
N 0

Dimensions Width (W) wg_w
Depth (D) wg_w
Height(H) wg_h

Leave the name Cuboid2 (default name) in the Label field. Click
the Create button to create the cuboid.

Union and simplify cuboids

The cuboids (Cuboid1 and Cuboid2) must be unioned in order
to become a single geometry part. Select Cuboid1 and Cuboid2

in the model tree using the <Ctrl> key. Select the Construct tab and
click the Union icon (Modify group).

The union of the two cuboids (Union1) will now be simplified. Select Union1 in the
model tree and select the Transform tab. Click the Simplify icon (Simplify group) to

launch dialog with simplification options. Leave the default settings as is and click the Create
button. The simplification process removes items that are redundant; in this example the face
between the two cuboids (where they touch) is removed.

Set waveguide to be hollow

The waveguide section that has been constructed is currently still
solid metal, but needs to be hollow with metal side walls. We
need to set the region inside the waveguide to be Free space.

To set the properties of the interior region of the model, select
the part (Union1) in the model tree. The details tree now shows
a Regions branch. Expand this branch to see a list of available
regions. In this geometry part only one region (the inside of the
waveguide) exists. Right-click this region, and select Properties.
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In the region properties dialog, set the Region medium
to Free space. Click the OK button to accept and close.

Union waveguide and power dividing pin

The waveguide sections (Union1) and the cylinder (Cylinder1)
must be unioned to become a single geometry part. Select

Union1 and Cylinder1 in the model tree. Select the Construct tab
and click the Union icon (Modify group).

Add wavguide ports

We have created the geometry and we are now going to
add the waveguide ports and the source.

In the 3D view, continue to left-click the face where
Port1 should be placed (the face at the maximum

X position) until the required face is highlighted. Open
the context menu (right-click) of the face and selecting
Create port→Waveguide port (also available under the
Source/Load tab in the Ports group. Use the default label
of Port1.

Note that ports are simply connection points on the ge-
ometry where sources can be added. Waveguide ports
that do not have sources are considered to be absorbing
waveguide terminations.

The Create waveguide port dialog is displayed. Note that
the correct face label is already entered in the Face field
due to first selecting the face in the 3D view.
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Whilst the Create waveguide port (geometry) dialog is open,
a preview of the waveguide port will be indicated in green
in the 3D window. Note that the reference vector is a silver
line on the port face from the centre going in the positive
Z direction.

The default label for the port (Port1) should be used for this
example. Click the Add button, but do not close the dialog.

To add the second port, click the Face edit box (it has a yellow background colour when it is
selected) and then select the face where the second port should be placed (the face at the most
negative Y position or the geometry). The default port label, Port2, can be used. Click the Add
button to create the waveguide port.

The third port is added in the same way as the other ports. The correct face for Port3 is the
face at the most positive Y position in the geometry. Select the 180 degrees option to ensure the
correct reference direction for the third port.

Click the Create button to define the final waveguide port and close the dialog.

If all the steps have been followed correctly, the structure
should look similar to the image. Note the port locations.

It may be necessary to enable the annotations by
clicking the Port annotations icon in the Entity dis-

play group (Display options tab of the 3D View contextual
tab group).

Add waveguide source to port 1

The waveguide source can now be added to port 1. Select the Source/Load tab and click
the Waveguide source icon (Sources on ports group). Select Port1 from the dropdown

menu.

All the default values are used in this example. The
fundamental mode for this source will be excited
(T E10). It is also possible to add multiple modes
as a single source by choosing the Specify modes
manually option.

Click the Create button.
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Sources may also be added to ports via the model tree. Right-click
Port1 in the model tree and select Waveguide source from the con-
text menu.

Set the simulation frequency

Select the Source/Load tab and click the Fre-
quency icon (Settings group) to open the Solu-

tion frequency dialog. A variable was created at the be-
ginning of this example that contains the solution fre-
quency. Enter freq in the Frequency field by selecting
the editbox and then holding down <Ctrl><Shift> and
clicking with the mouse the variable freq in the tree.
With the frequency set to freq, the actual frequency is
9 GHz.

The solution frequency can be seen on the Configuration tab once
the solution frequency dialog has been closed.

Define model symmetry

The model contains symmetry, but first the geometry must be moved so that symmetry can be
utilised. The symmetry planes are only possible at X, Y or Z equal to zero.
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Select the geometry (there should only be a single unioned
part) in the model tree and click the Transform tab. Click the

Translate icon (Transform group). Set the From and To fields as indi-
cated.

Group Field Expression

From U 0
V 0
N wg_h/2

To U 0
V 0
N 0

This translation will move the structure down so that it is symmetrical
around the Z=0 plane. Click the OK button to apply the translation
and close the dialog.

The model has magnetic symmetry at Y=0 and electric symmetry at Z=0.
The required resources (memory and time) can be reduced by allowing
the solution kernel to utilise symmetry. Note that this step is optional
and the user is encouraged to remove symmetry later to compare the
difference in solution time and memory usage.

Select the Solve/Run tab and click the Symmetry icon (Solution
settings group). Set Magnetic symmetry at the Y=0 plane and

Electric symmetry at the Z=0 plane.

The symmetry display may be hidden by selecting the Display options
tab in the 3D view context. Click the Symmetry icon (Solver display

group) to hide the symmetry in the 3D view.
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Add a near field request

The near field values on a surface through the centre
of the waveguide will now be calculated.

Select the Request tab and click the Near
fields icon (Solution requests group) to dis-

play the Request near fields dialog. Enter the values
as indicated.

Dimension Start End No. of Points

U -10 30 32
V -20 20 32
N 0 0 1

Note that near field requests on PEC boundaries will
result in a warning by the FEKO solution kernel, this
is the reason why the option to sample on edges has
been unselected.

Leave the default label as NearField1.

Click the Create button.

5.4 Mesh creation

The geometry was created, but still has to be meshed before the FEKO solver can be used to
simulate the model. Three of the faces require a finer mesh than other faces. The faces that
require a finer mesh are the ones that have waveguide ports on them (mesh should be fine
enough to represent the highest mode that should be taken into account).

A finer mesh is required on the waveguide port faces. Select the
geometry in the model tree. The three faces that must be refined
can be selected in the details tree (or the 3D view). Right-click the
faces (in the details tree) and select Properties.

Select the Meshing tab. Set the local mesh size
to lambda/20. Click the OK button to close the
dialog.
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Now the model can be meshed. Select the Mesh tab and click
the Create mesh icon (Meshing group). Use the default settings
and click the Mesh icon to create a mesh and close the dialog.
The shortcut key <Ctrl><M> may also be used to launch the
Create mesh dialog.

Finally save the model as gs_magicTwaveguide (or any other file name) in a directory of
your choice. The CADFEKO message windows will indicate that four files have been saved.

5.5 CEM validate

The model should now be computational electromagnetically validated. The purpose of this
validation is to ensure that errors regarding the Frequency, Geometry, Mesh and Solution are
found and corrected before the FEKO solver is run.

Run the CEM validate by selecting the Solve/Run tab and click the CEM validate icon
(Validate group). When any errors are found, a respective error can be selected to display

a short description of the error being shown in the Error/Warning details of the selected item
window.

5.6 Obtaining a solution

After completing the model preparation, the solver should be invoked to calculate the requested
results. The solver can be invoked in a number of ways, from a command window or from any
one of the GUI components. In this example, the solver will be invoked from CADFEKO.

To invoke the solver from CADFEKO select the Solve/Run tab and click the FEKO solver
icon (Run/launch group). A window will open, indicating the progress of the simulation.
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5.7 Visualisation of results

POSTFEKO is used to view and post-process all FEKO results. This user interface provides the
viewing of 3D results (far fields, near fields, currents, etc.) with the geometry and the plotting
and exporting of 2D graphic results.

This example will show how to view the reflection coefficient at Port1 on a 2D Cartesian graph
and the near field values inside and outside the waveguide.

To launch POSTFEKO, click the Run POSTFEKO icon
on the application launcher. POSTFEKO opens with

the waveguide power divider displayed in the 3D view.

A new graph that plots information relating to the waveguide source is created by clicking
the Cartesian icon (Home tab, Create new display group).

Add the reflection coefficient data point by clicking the Source
data icon (Home tab, Add results group) and selecting Waveg-

uideSource1 from the dropdown menu. Reflection coefficient is often
quoted in dB.

To set the vertical scale of the graph to dB, check the dB checkbox in
the Result palette, Quantity section.

To add an annotation to the data point, select the Measure tab on the Cartesian contextual
tab. Click the Point icon (Custom annotations group) and select Global maximum from the

dropdown menu. The annotation shows that the power reflected back to the Port1 is more than
30 dB lower than the power applied to the same port.

We now want to add the calculated near field values onto the 3D view. Select the 3D view by
clicking the 3D view window tab.

The display of the symmetry planes may be disabled
by selecting the Display tab on the 3D view contextual

tab. Click the Symmetry icon (Method display) to disable the
display of the symmetry planes.
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The mesh opacity of the waveguide may be enabled by
clicking the Mesh tab of the 3D View contextual tab.

Click the Mesh opacity icon (Opacity group) and from the
dropdown list, select a value (for example 40%). If a spe-
cific value is required the value may be specified by selecting
Custom... from the menu. The setting of the mesh opacity is
required to be able to view the near field inside the waveguide.

We can now click the Near field icon (Add results group on the Home or Result tab). Select
NearField1 from the dropdown menu. The near field result is immediately displayed.

To animate the phase of the near field, in the Result palette, Quantity section, select In-
stantaneous magnitude. In the 3D View context and select the Animate tab. Click the Type

icon (Settings group). From the dropdown list select Phase. To start the animation process, click
the Play icon (Play group). Click the Play icon again to terminate the animation.

5.8 Closing remarks

A waveguide section with three waveguide ports has been simulated. The time evolution of the
near field values in a plane has been displayed with the 3D model.

Symmetry was utilised in two planes to reduce system requirements. Symmetry reduces both
time and memory (RAM) required and is present in many real life problems. The user is encour-
aged to use symmetry when possible and also to investigate the difference in required resources
when symmetry is enabled and disabled.
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6 Getting started: Optimising the gain of a bent dipole

6.1 Example overview

The gain of a bent dipole placed in front of a square metallic reflector is maximised. The distance
between the reflector and the bent dipole (d) as well as the dipole bend-angle (α) are varied in
the optimisation. The goal is to maximise the maximum gain in the azimuth plane at a single
frequency. The model geometry and related parameters are illustrated in Figure 6-1.

The model utilises symmetry to reduce memory requirements and to increase the calculation
speed. Even though this is a small model that does not require a lot of resources, symmetry is
used to illustrate the decreased resources required when utilising symmetry.

Figure 6-1: Sketch of the model.

6.2 Before starting the example

Before starting this example, please ensure that the system satisfies the minimum requirements
before starting. A user should also ascertain whether the topics presented in this example are
relevant to the intended application and FEKO experience level.

The topics demonstrated in this example are:

• Defining optimisation in CADFEKO.

• Running the FEKO optimiser (OPTFEKO).

• Adding a voltage source to a wire segment.

• Viewing optimisation results in POSTFEKO.
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The requirements for this example are listed below.

• FEKO 2017.2 RELEASE or later should be installeda with a valid licence.

• It is recommended that the demo video be watched before attempting this example.

• Working through this example should not require more than about 30 minutes.

aSee the FEKO Installation Guide to install Altair FEKO.

While working through this example, the steps should be followed sequentially, otherwise expla-
nations may seem to be out of context.

The model referred to in this example can be found in the

examples/GetStarted_models/Project6-Optimisation_of_a_Dipole

directory of the Altair FEKO installation or downloaded from our website.

6.3 Creation of the model in CADFEKO

The first step in every FEKO solution is to construct the model. Start by launching CADFEKO
which opens with the start page. Click Create a new model to create a new model. The model is
created using CADFEKO and stored in the *.cfx file.

The steps that we are going to follow to create the model are:

• Define variables to parametrise the model.

• Add the reflector and bent dipole geometry.

• Add a source to the dipole.

• Set the frequency of the solution.

• Set the symmetry planes to use.

• Add a far field request.

• Add the optimisation request.

CADFEKO should now be open with a new, empty model.

Define variables

Variables may be defined by selecting the Construct tab and clicking the Variable icon
(Define group).

Variables may also be defined via the tree. Right-click the Variables group in the model tree
and select Add variable. A short comment for a variable can be added to the Comment field.
The inclusion of comments for variables is optional. The variable’s comment is displayed when
one hovers the mouse over the variable name (if available).
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Create the following variables:

Name Expression

alpha 60
alpha_rad alpha*pi/180
d 0.25
lambda 1
freq c0/lambda

Create reflector (rectangle)

Create a rectangle by selecting the Construct tab and click-
ing the Rectangle icon (Create surface group). Select the

base centre, width, depth definition method.

Enter the following values in the fields:

Field Value

Width lambda
Depth lambda
Label Reflector

The workplane of the Reflector will now be modified. Se-
lect the Workplane tab of the Create rectangle dialog. Be-

low the Rotate workplane groupbox, click once the middle icon
to rotate the workplane 90◦ around the V axis.

Click the Create button.

Create dipole (polyline)

Click the Polyline icon (Create curve group) to launch the
Create polyline dialog.

We are going to create the bent dipole on a new workplane so
that it can be easily moved. Select the Workplane tab and set
the local origin to (d, 0, 0) as indicated in the image. Note
that variables and named points can also be entered by press-
ing <Ctrl><Shift> and clicking with the mouse on the variable
or point in the tree.

Below the Rotate workplane groupbox, rotate the work-
plane by 180 degrees around the V axis by entering the

angle of 180 and clicking the middle icon. The result of this ac-
tion is shown in the image (right). Note the new orientation and
position of the workplane in the 3D view. Return to the Geometry
tab.
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Create a polyline with the three corners listed in the table below.
Use the Add button to add the third corner.

Corner Coordinate Expression

1 U lambda/4*cos(alpha_rad)
V 0
N lambda/4*sin(alpha_rad)

2 U 0
V 0
N 0

3 U lambda/4*cos(alpha_rad)
V 0
N -lambda/4*sin(alpha_rad)

Name the polyline Bent_dipole by typing the name in the Label
field. Click Create to create the polyline and close the dialog.

If all the steps have been followed correctly, the created geom-
etry should be similar to this image.

Define the port

We have now created the geometry and need to add a port where the dipole can be excited.

Select the Source/Load tab and click Wire port (Ports
group).

The Create wire port dialog is displayed. Ensure that the Edge
field is yellow to indicate that the field can be populated by
selecting an item with the mouse. Use the mouse to select
the top part of the Bent_dipole in the 3D view.

Set the port location to the Start of the Vertex. A completed
Create wire port dialog is shown in the image, please ensure
that all settings are correct. It should be noted that the name
of the wire edge may differ, but it should be Bent_dipole.Wire
followed by a number.

Click Create to add the port and close the dialog. This should
result in a port at the centre of the dipole on the 3D window.
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Add the voltage source

Add a voltage source to the port by selecting the
Source/Load tab and click the Voltage source icon (Sources

on ports group). Create a voltage source on Port1.

Define the simulation frequency

Click the Frequency icon to open the Solution fre-
quency dialog. A variable was created at the be-

ginning of this example that contains the solution fre-
quency. Enter freq in the Frequency field.

With the frequency set to freq, the actual frequency is
299.792 MHz. This can be seen in the tree once the solution fre-
quency dialog has been closed.

Define model symmetry

The model has magnetic symmetry at Y=0 and geometric symmetry at
Z=0. The required resources (memory and solution time) can be reduced
by allowing the solution kernel to utilise symmetry. Note that this step
is optional and the user is encouraged to remove symmetry later and to
compare the difference in solution time and memory usage.

Select the Solve/Run tab and click Symmetry. Set the Magnetic symmetry
at the Y=0 plane and Geometric symmetry at the Z=0 plane. Click the
OK button to define the symmetry and close the dialog.

Setup the solution request

The far field gain in the azimuth direction is going to be optimised. This means that a far field
request in the azimuth direction has to be requested.
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Select the Request tab and click the Far fields
icon (Solution requests group). Click the Hor-

izontal cut (UV plane) to request the far field gain
to be calculated in the azimuth direction. Leave the
default label as FarField1. Click Create to create the
far field request and close the dialog.

Define the optimisation search

Select the Request tab and click the Add search button
(Optimisation group) to launch the Add optimisation

search dialog. Set the optimisation convergence accuracy to
Normal (default). The other settings should not be changed.
We are using the Automatic setting as method type. This
allows FEKO to decide what method to use. Click Create to
create a new optimisation search.

Right-click Parameters in the model tree. Click Parameters in the
context menu.

The Optimisation parameters dialog is displayed. Use the Add button to add another parameter.
The two parameters that should be selected is d and alpha. Setup the optimisation parameters
as indicated in the image. Click the OK button once the setup is complete.
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We want to maximise the far field gain in the azimuth plane. We have already requested that the
far field should be calculated. We now set up the optimisation goal.

Ensure that the optimisation search, Search1, is selected in the tree and then select the Re-
quest tab and click the Add goal function icon (Optimisation group). From the dropdown

menu select Far field goal. Note that the goals will be disabled if the optimisation is not currently
selected in the tree.

The Create far field goal dialog is divided into a few sections that will briefly be discussed.

• The first section is the Goal focus and is the calculation that should be performed by the
FEKO solver. In our case, we select FarField1 that was created earlier. We also select the
component that we are interested in, namely the Gain of the far field. Select Total as the
polarisation type.

• The Focus processing steps allow processing of the focus before it is compared to the objec-
tive. Select Maximum to use only the maximum value of the total far field gain.

• The Goal operator describes how the objective and focus is compared. We want to maximise
the gain, so select Maximise as a goal operator.

• Goal objective is what the value of the focus is compared to. Note that there is no Goal
objective for maximisation or minimisation.

• A Weight can be defined for each goal. This weighting is used to modify the contribution
of the goal’s error to the global error during the fitness evaluation.

Enter all the fields as they are in the image.
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6.4 Mesh creation

The geometry has been created, but still has to be meshed before the FEKO solver can be run.

Select the Mesh tab and click the Create mesh icon (Meshing
group) or use the shortcut key <Ctrl><M>. For the Mesh size
set the size as Coarse. Set the Wire segment radius as 0.001 and
click the Mesh icon.

Finally save the model as Dipole_Optimisation (or any other file
name) in a directory of your choice. Click the Application menu and from

the dropdown menu click the Save as icon. The CADFEKO message windows
will indicate that six files have been saved.

6.5 Obtaining a solution and displaying the results

The model has now been completely configured and is ready to be solved and viewed. The steps
required to view the results are:

• Run the CEM validate.

• Run the FEKO solver once to test the model and produce initial output for POSTFEKO.

• Open POSTFEKO and configure the views that we want to look at during optimisation.

• Launch the optimisation.

• View the optimisation results.

The model should now be computational electromagnetically validated. The purpose of this
validation is to ensure that errors regarding the Frequency, Geometry, Mesh and Solution are
found and corrected before the FEKO solver is run.
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CEM validation

Select the Solve/Run tab and click the CEM validate icon (Validate group).

When any errors are found, an error can be selected, resulting in a short description of the
error being shown in the Error/Warning details of the selected item window.

Run FEKO solver (not the optimisation)

Next, a single FEKO run is performed. The short-
cut keys <Alt><4>, the application launcher or the

ribbon can be used to launch the FEKO solver. Select the
Solve/Run tab and click the FEKO solver icon (Run/Launch
group). This should not take longer than a few seconds
and no warnings or errors should be reported. Close the
message window once the run has completed.

Set up graphs and views in POSTFEKO

Run POSTFEKO by using the <Alt><3> shortcut key, application launchers or from the
CADFEKO ribbon. POSTFEKO opens by default with a single 3D window that displays the

geometry of the model.

Click the Far field icon (Home tab, Add results group) and from the dropdown menu select
FarField1.

Add a 2D optimisation graph by selecting the Home tab and clicking the Cartesian icon
(Create new display group).

Add the optimisation result by clicking the Optimisation icon (Add results group) and
selecting Optimisation from the dropdown list.

In the Result palette, Slice section, set the Trace to alpha.
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Create two additional Cartesian graphs and in the Result palette set the Trace to d and
search1.goals.farfieldgoal1 respectively.

The four windows can be neatly positioned for easy viewing during optimisation by select-
ing the Tile icon (View tab, Window group).

Run the optimisation

All that remains is to run OPTFEKO. On the Home tab, click the OPTFEKO icon
(Run/launch group) or use the application launcher. POSTFEKO will automatically up-

date the displayed graphs.

The run dialog is displayed in a condensed format. It is advisable to view any warnings, errors or
notes that are indicated in the dialog by clicking the Details button. The convergence information
as well as the parameters of the optimal solution is displayed in the run dialog at the end of the
optimisation run. Click the Details button to see the complete list of output.

After the optimisation has completed, the message window displays the optimisation results. We
see that the optimum value for ‘alpha’ is 82.557◦ and 0.784 m for ‘d’. With these values, the
maximum gain is 5.41 (linear). When the optimiser has enough information to do a sensitivity
analysis, these results will also be displayed.

View optimisation results in POSTFEKO

In POSTFEKO all the graphs have now been populated with the details of the optimisation pro-
cess. We can clearly see how the goal that we setup has reached a maximum value at the end of
the optimisation. For more details on the optimisation process, a log file named gs_dipole.log
has been created in the project directory.
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The optimiser creates a new CADFEKO model (*.cfx) with the variables set to the optimum
values. This model is located in the same directory as the current model, but the name has been
extended with _optimum.

6.6 Closing remarks

This example has demonstrated how to configure a CADFEKO model as well as how optimisation
in CADFEKO is used. The optimisation process as well as the optimum values for the model
parameters were displayed in POSTFEKO, but can also be viewed in the log file.
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